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Patent och varumärken
ProteinSimples Simple Plex-teknik täcks av utfärdade och sökta patent i USA och andra länder. Mer information 
finns på:  bio-techne.com/support/instrument-support/intellectual-property

ProteinSimple, ProteinSimple-logotypen, Simple Plex och Ella är varumärken eller registrerade varumärken som 
tillhör ProteinSimple. Andra varumärken som förekommer i dessa material tillhör sina respektive ägare.

Meddelanden om immateriell egendom
Denna handbok omfattas av upphovsrättslagar i USA och internationellt. Ingen del av denna handbok får 
reproduceras, modifieras eller överföras helt eller delvis i någon form eller på något sätt, elektroniskt eller 
mekaniskt, inklusive fotokopiering, inspelning eller något informationslagrings- och hämtningssystem, utan 
skriftligt tillstånd från ProteinSimple. ProteinSimple tillåter härmed kunder som har köpt Ella att göra ett begränsat
antal fotokopior eller elektroniska kopior av denna handbok, utan modifieringar, som de kan behöva för sin egen 
användning om sådan användning begränsas för installation eller användning av Ella.

Programvaran Simple Plex omfattas av licenserna som anges i ProteinSimples standardvillkor.

mailto:support@bio-techne.com
http://bio-techne.com/support/instrument-support/intellectual-property
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Ellas friskrivning från garanti
Med undantag för vad som uttryckligen anges några licensavtal eller prisuppgifter för programvaran 
ProteinSimple, tillhandahålls produkterna som säljs och tjänsterna som tillhandahålls av ProteinSimple ”i befintligt 
skick” och ”i mån av tillgänglighet” utan någon som helst garanti. ProteinSimple och dess leverantörer garanterar 
inte säkerheten, sekretessen eller riktigheten av några data som tillhandahålls via produkterna eller tjänsterna, 
och du samtycker till att din användning av sådana data sker på egen risk. I den utsträckning som tillåts enligt 
gällande lag frånsäger sig ProteinSimple och dess leverantörer alla garantier, vare sig uttryckliga, underförstådda 
eller lagstadgade, inklusive, utan begränsning, alla garantier om säljbarhet, äganderätt, icke-intrång eller 
lämplighet för ett visst ändamål.

Omfattning
För korrekt användning av systemet och/eller alla ingående delar måste instruktionerna i denna handbok följas 
strikt och noggrant av erfaren personal. Allt innehåll i denna handbok måste läsas och förstås fullständigt innan 
systemet eller någon del av det används. Underlåtenhet att fullständigt läsa, förstå och följa allt innehåll i denna 
handbok innan systemet eller delar därav används kan leda till skada på utrustningen eller delar av den, samt 
personskador för operatörer.

Avsett ändamål
Det avsedda ändamålet för Ella-instrumentet är följande:

Ella är ett icke-automatiserat instrument som är avsett för in vitro-diagnostisk användning för att utföra 
immunanalysdiagnostik tillsammans med en Ella-analys som stöds. Ella-instrumentet sekvenserar 
bearbetning av prover, reagenser och tvättbuffertar och mäter och sorterar fluorescenssignaler med hjälp 
av en Ella analyskit som stöds. Ella-instrumentet är avsett att användas av utbildad laboratoriepersonal.

Ella-instrumentet ska användas i professionella vårdmiljöer (t.ex. kliniska laboratorier, sjukhus, kliniker).  
Ella-systemet är inte avsett för användning i patientnära miljöer eller för självtestning. Rimligt förutsebar felaktig 
användning av produkten inkluderar följande. 1. Användning av outbildade användare 2. Användning med 
kassetter som inte stöds.

Testprincip
Ella-instrumentet använder en sandwich-immunanalysprincip som omfattar följande steg:

Först fångas målantigenet med en fast fas nanoreaktor av glas belagd med en specifik bindningsantikropp 
för antigenet. Provet körs genom kassetten för att binda målantigenet till bindningsantikroppen. En 
detektionsantikropp som binder till antigenet konjugeras till en fluorescerande etikett och förs in för att bilda 
ett ”sandwich”-komplex. När obundna substanser tvättats bort läser instrumentet kassetten och relativa 
fluorescensenheter rapporteras. Signalens intensitet är i direkt proportion till mängden antigen som finns i provet. 
Koncentrationen av antigenet i provet kan fastställas genom att jämföra signalen som erhålls från provet med en 
standardkurva som genereras från kända koncentrationer av antigenet. Denna princip möjliggör högspecifik och 
känslig kvantifiering av antigener i olika prover.

Varning och kvarvarande risk
Inga identifierade.
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Beskrivningar av etiketter och symboler

Symbol Beskrivning

FÖRSIKTIGHET 
Se medföljande dokumentation

NRTL-godkännandemärke 
Elektriskt säkerhetsgodkännande till UL61010-1:2012; EN61010-1:2010; 
CAN/CSA C22.2 61010-1:2012

Tillverkarens försäkran att produkten uppfyller de väsentliga kraven i alla relevanta EU-direktiv.

WEEE-symbol 
Separat insamling för elektrisk och elektronisk utrustning.

Tillverkare 
Anger tillverkaren av den medicintekniska produkten, enligt definitionen i IVDR (2017/746).

In vitro-diagnostisk medicinteknisk produkt 
Anger en medicinteknisk produkt som är avsedd att användas som en medicinteknisk produkt för 
in vitro-diagnostik.

Katalognummer 
Anger tillverkarens katalognummer så att den medicintekniska produkten kan identifieras.

Unik enhetsidentifierare 
En unik numerisk eller alfanumerisk kod som underlättar spårning och identifiering av enheten
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Kapitel 1

Möt Ella
Funktion/avsedd användning
Ella™ är ett helautomatiskt kassettbaserat system som gör det möjligt för forskare att mäta biomarkörer i flera 
provtyper. Ella, tillsammans med mikrofluidikteknik (Simple Plex™-kassetter), möjliggör mätningar med en analyt, 
mätning av flera analyter parallellt (multianalyt) och även multiplexmätningar. Forskare kan också konfigurera 
Simple Plex-kassetter så att de är unika för sin egen forskning. 

Med Ella kan du: 

•	 Utföra ett immunanalysprotokoll automatiskt 

•	 Samla in och bearbeta data automatiskt 

•	 Visa och analysera fluorescens- och koncentrationsdata baserat på analyt och prov 

•	 Extrahera och spara fluorescens- och koncentrationsinformation för applikationsspecifik analys 

VARNING: Ella-systemet är inte avsett för användning i patientnära miljöer eller för självtestning.

Specifikationer
Detta avsnitt beskriver Ella:s specifikationer, inklusive miljöförhållanden, elektriska märkvärden, fysiska 
förhållanden, laserklassificering och extern fusion 

TA B E L L  //   02

Instrumentspecifikationer

Miljöförhållanden
Endast för inomhusbruk
Altitud upp till 2 000 m (6 500 fot) 
Temperatur: 18 °C till 30 °C (65 °F till 86 °F) 
Luftfuktighet: 15 till 80 % relativ luftfuktighet, inklusivt, icke-kondenserande

Förvarings- och 
transportförhållanden

Temperatur: -18 °C till 50 °C (0,4 °F till 122 °F)
Luftfuktighet: RH ≤ 85 % icke-kondenserande 

Fysiska förhållanden
Totala mått: 37 cm (b) x 54 cm (d) x 26 cm (h)
                     14,6 tum (b) x 21,3 tum (d) x 10,2 tum (h) 
Vikt: 18,2 kg (40,1 lb)

Extern säkring Huvudsäkring (apparatingång): 4 A, 250 V; IEC 60127 klassad som T4AL 250 V

Elektriska märkvärden 100–240 V(AC), 300 VA, 45/65 Hz, klass I installationskategori (överspänning) II 
OBS! De elektriska värden som anges är nominella

Specifikationer för 
elektriskt test

CB-schema: IEC 61010-1:2010

TÜV SÜD ”CUE”-schema:
CAN/CSA-C22.2 nr 61010-1:2012
UL 61010-1:2012/R:2019-07
EN 61010-1:2012/R:2019-07
EN 60825-1:2014

Klass 1 laserprodukt enligt IEC 60825-1:2014 och EN 60825-1:2014

Uppfyller FDA:s prestandastandarder för laserprodukter 21 CFR 1040.10 och 1040.11 med 
undantag för avvikelser i enlighet med lasermeddelande nr 50, daterat den 24 juni 2007.
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VARNING: Ta inte bort Ella:s huvudkåpa. Det finns inga komponenter inuti som kan servas av användaren 
och du kan exponeras för högspänning.

VARNING: Användning av andra kontroller, justering eller utförande av andra procedurer än de som 
specificeras här kan leda till farlig exponering för laserljus.

Försiktighetsåtgärder och varningar
Följande avsnitt beskriver säkerhetsåtgärder som du bör iaktta när du använder Ella.

Dessa inkluderar försiktighetsåtgärder för:

•	 Allmän säkerhet

•	 Elektrisk säkerhet

•	 Laserljussäkerhet

Allmänna säkerhetsåtgärder
VARNING: Operatörer av Ella ska utbildas av kvalificerad personal att använda instrumentet korrekt och vara 
medveten om säkerhetsfrågorna 

Försiktighetsåtgärder avseende elektrisk säkerhet
Detta avsnitt beskriver elektriska säkerhetsåtgärder för Ella:s elanslutningar och säkringar samt 
högspänningsrisker.

Elanslutningar
Anslut Ella till en jordad krets som kan leverera minst:

•	 15 A för 100 volt till 120 volt strömkälla

•	 12 A för 200 volt till 240 volt strömkälla. Se tillverkarens etikett på baksidan av Ella för mer information.

Säkring
Den primära ingångssäkringshållaren sitter på höger sida av baksidan av Ella och innehåller en 4 A, 250 V 
långsam säkring. Säkringshållaren är utformad för att rymma en 5 mm x 20 mm säkring. Utbytessäkringar ska 
uppfylla specifikationen IEC 60127 och vara klassificerade som T4AL 250V.

VARNING: Stäng av Ella och koppla bort nätsladden innan du byter säkringen. Om en säkring behöver 
bytas ofta kan Ella ha ett elektriskt problem. Använd inte Ella i sådana fall. Du kan utsättas för elektriska 
stötar. Kontakta teknisk support hos Bio-Techne för hjälp.

Risker och försiktighetsåtgärder för högspänning
Datorn och bildskärmen innehåller högspänningselektronik. Se försiktighetsåtgärderna för datorn och 
bildskärmen innan du startar datorn eller bildskärmen.

Försiktighetsåtgärder för laserljussäkerhet

Ella är ett laserinstrument i klass 1 som innehåller en laser i klass 3B som drivs med våglängden 640 nm. Under 
de specificerade användningsprocedurerna tillåter inte Ella att operatören exponeras för laserljus. Ella-systemets 
laserdesign uppfyller kraven i IEC (EN) 60625-1-2014.
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VARNING: Försök inte få åtkomst till Ella:s inre genom någon öppning. Exponering för laserljus kan orsaka 
personskada. Att till exempel titta på laserljuset direkt kan orsaka blindhet.

VARNING: Användning av kontroller eller justeringar, eller utförande av andra procedurer än de som 
anges här, kan leda till exponering för farlig strålning.

Observera följande försiktighetsåtgärder:

•	 Ta inte bort Ella:s huvudkåpa. Det finns inga komponenter inuti som kan servas av användaren och du kan 
exponeras för laserljus.

•	 Fortsätt inte att använda Ella om huvudlocket eller kassettlocket skadas och inte längre är ljustätt. Kontakta 
omedelbart support hos Bio-Techne för att ordna en reparation.

Rapportering av negativa händelser
Om du behöver rapportera ett allvarligt tillbud som har inträffat med denna medicintekniska produkt ska du 
kontakta tillverkningsplatsen (se Tillverkarens kontaktuppgifter) och kontakta den nationella tillsynsmyndigheten 
där användaren och patienten är etablerade. 

Användarkvalificeringar
Personal som använder, utför underhåll på eller rengör Ella ska utbildas i standardsäkerhetsrutiner för laboratorier 
och ska följa dessa rutiner när de hanterar instrumentet. De ska vara fullt kvalificerade och utbildade att använda 
Ella-systemet, ha läst och fullständigt förstått instruktionerna i denna användarhandbok och vara förtrogna med 
tillämpliga säkerhetsbestämmelser och direktiv för användningsmiljön.

Installera Ella
Ella måste installeras av utbildad personal från Bio-Techne med lämplig installations- och operatörskvalifikationer. 
Ella får bara användas efter mottagning av ett undertecknat formulär från en Bio-Techne-anställd som 
dokumenterar en lyckad IQ OQ-procedur.

Flytta Ella
Ella är ett känsligt optiskt instrument och kan skadas om det flyttas på fel sätt. Instrumentet kan skadas om det 
tappas. Stäng alltid av Ella innan du flyttar den. Se instruktionerna ”Förbereda Ella för frakt” på sidan 22 för en 
vägledning om hur du förbereder Ella för en flytt.

VARNING: Denna produkt måste lyftas av två personer. Tunga lyft kan orsaka personskada. Använd 
korrekt lyftteknik.

VARNING: Placera inte Ella nära någon enhet som kan avge kraftiga vibrationer (t.ex. en vortexblandare) 
eftersom det kan störa mätningarna.

Kassera innehållet/behållarna i enlighet med lokala, kommunala, nationella och internationella 
förordningar. Granska säkerhetsdatabladen (SDS) för att ta reda på hur material kasseras på ett säkert 
sätt i din region.

Kassera Ella
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Anslutningar: Ella till dator
OBS! Endast ett Ella-instrument kan anslutas och styras per dator. Flera instrument kan inte anslutas till 
samma dator.

1.	 Växelströmskabel 
Används för att tillföra nätström till Ella. Växelströmskabeln ska ha en IEC 320 honkontakt i ena änden  
(Ella-anslutning) och en landsspecifik hankontakt i den andra änden. Nätkablar ska vara UL-listade och  
CSA-certifierade med ampereklassning som uppfyller Ella:s elektriska specifikation.

2.	Ethernet-kabel (svart) 
Används för kommunikation med höghastighetskameran inuti instrumentet.

3.	USB-kabel 
Används för kommunikation med alla andra funktioner i instrumentet.

Ella-systemets sammankopplingar
Figur 02 är en översikt på hög nivå över sammankopplingarna mellan Ella, datorn, bildskärmen, tangentbordet och 
streckkodsscannern. Se de specifika inställningsanvisningarna för din Ella och PC.

F I G U R  //   0 1

Anslutningar för Ella

F I G U R  //   02

Ella-anslutning till dator samt stöd för kringutrustning

USB-kabel

Ethernet-kabel

Växelströmskabel

PCElla
USB-kabelUSB-kabel

Ethernet-kabel

Växelström

Streckkodsskanner

Trådlös kringutrustning

Växelström
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Minimikrav på IT och maskinvara
Det finns inga IT-nätverkskrav för Ella. Vi rekommenderar du inte upprättar några nätverksanslutningar till Ella. 
Ella fungerar som ett fristående system och är avsett att fungera oberoende av en nätverksanslutning. Alla 
anslutningar till ett nätverk, antingen inom- eller mellannät, görs på egen risk. 

Ella kräver ingen ytterligare maskinvara för att fungera. Att ansluta ytterligare maskinvara till Ella rekommenderas 
inte och görs på egen risk.

IT-säkerhetsåtgärder
Kunden ska:

1.	 Kontrollera fysisk åtkomst till instrumentet för att förhindra obehörig åtkomst 

2.	Begränsa åtkomst till enhetens USB-port och endast använda tillförlitliga flyttbara media 

Kontakta kundtjänst
Kontakta kundtjänst för kundsupport eller beställningsinformation. 
Kontakta teknisk support om du behöver teknisk support.

Webb		  www.bio-techne.com/brands/proteinsimple

Kundtjänst Telefon		  1-408-510-5500 
			   1-888-607-9692 (endast avgiftsfritt i USA och Kanada)

E-post		  orders@proteinsimple.com

Teknisk 
support

Telefon		  1-408-510-5500 
			   1-888-607-9692 (endast avgiftsfritt i USA och Kanada)

E-post		  support@bio-techne.com
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Kapitel 2

Starta Ella
Inledning
Ella är ett helautomatiskt kassettbaserat system som gör det möjligt att utföra immunanalyser med flera analyter 
med specificiteten hos en traditionell enkelplex-ELISA (enzymlänkad immunabsorberande analys).

Med Ella kan du:

• Utföra ett immunanalysprotokoll automatiskt

• Samla in och bearbeta intensitetsdata automatiskt

• Visa och analysera intensitets- och koncentrationsdata

• Extrahera och spara information om intensitet och koncentration för applikationsspecifik analys

Ella-systemets komponenter
Ella består av fem huvudkomponenter:

1. Ella instrument/avläsare

2. Streckkodsläsare

3. Persondator

4. Runner CE-programvara

5. Verifieringskassett (Simple Plex-kassetter kan köpas separat)

Ella
En huvudkomponent i Ella-systemet är en bordsanalysator utan inbyggd fluidik som avsevärt minskar avfallet och
behovet av förebyggande underhåll.

Ella har utformats för att ”ladda och köra” och styr mikrofluidikanalyskassetten genom att exakt manipulera 
volymer, flödeshastigheter och flödesmönster utan mänskligt ingrepp. Efter analysdelen av en körning utför Ella 
automatiskt fluorescensskanning, rådatabearbetning och beräkning av RFU (relativa fluorescensenheter) baserat
på koncentrationer per analyt och prov. En nätkabel medföljer instrumentet.

Streckkodsläsare
Ella-systemet inkluderar en handhållen streckkodsläsare för allmänt bruk som kan skanna både 1D- och
2D-streckkoder i alla riktningar. Varje kassettkit som levereras från Bio-Techne är märkt med en data-
matrisformad 2D-streckkod som innehåller alla relevanta kassettkitdata, inklusive:

• Lotinformation

• Information om biomarkörpanelen

• Konfigurationsiformation för kassetter

Varje kassettkörning börjar med att skanna kassettkitets streckkod för att ge användaren all information om
det relevanta kassettkitet och förse programvaran med nödvändiga data för att utföra kassettkörningen och 
rådatabearbetningen.
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F I G U R  //   03

Kassetter som kan användas med Ella.

VARNING: Konfigurationer som inte använder Runner CE-programvara och CE-märkta kassetter som 
stöds, överensstämmer inte med konfigurationen av det CE-märkta systemet.  

Persondator
En dator medföljer Ella så att du kan styra systemet. En USB-kabel och en nätverkskabel medföljer för att ansluta 
till Ella.

Simple Plex-programvara 
Runner CE är ett oanslutet programvarusystem som används för att köra kassetterna och gränssnittet med ett 
grafiskt användargränssnitt som har utvecklats av analysens utvecklare. Runner CE är förinstallerat på datorn 
som medföljer Ella-systemet. Kontakta Bio-Techne för information eller hjälp om att utveckla det grafiska 
användargränssnittet. 

Verifieringskassett
Verifieringskassetten tillhandahålls som en återanvändbar referens som är nödvändig för att utföra ett självtest av 
instrumentet. Se ”Ella självtest” på sida 21 för mer information.

Simple Plex-kassetter och -analyser
Den användningsklara IVD-kassetten finns tillgänglig i formatet med 32 prover och flera analyter (se Figur 03). 
Kassetten har utvecklats med en panel som är unik för din forskning så att du kan skanna streckkoden, mata in 
prover och buffert i kassetten, placera kassetten i Ella:s kassetthållare och köra kassetten. Simple Plex-kassetter 
och -analyser medföljer inte Ella-systemet. Använd endast med kassetter och analyskit märkta för användning 
med Ella-instrumentet. 

Varje kassett har många provingångar. Varje provingång har upp till 4 särskilt avsedda kanaler. En enda 
kanal innehåller tre nanoreaktorer av glas (GNR), som fungerar med en bindningsantikropp, så att du får tre 
rapporterbara resultat för varje provs analyt. GNR innehåller immunoanalysen och är baserad på R&D Systems 
reagenser för att säkerställa hög kvalitet och reproducerbar känslighet. Insamling av GNR:er i en viss kanal, i 
ett visst provinlopp, på en viss kassett är grunden för uppsättningen med mätningar som produceras när en 
Simple Plex-kassett körs.

Verifieringskassett

V E R I F I C A T I O N  C A R T R I D G E
BUFFER 1mL

1 2 3 4 5 6 7 8

BUFFER 1mL

BUFFER 1mL

9 10 11 12 13 14 15 16

BUFFER 1mL

C A L I B R A T I O N  C A R T R I D G E

DYE
25 µL

DYE
25 µL

BUFFER 1mL

1 2 3 4 5 6 7 8

BUFFER 1mL

BUFFER 1mL

9 10 11 12 13 14 15 16

BUFFER 1mL

BUFFER 1mL

17 18 19 20 21 22 23 24

BUFFER 1mL

BUFFER 1mL

25 26 27 28 29 30 31 32

BUFFER 1mL

SN 3456 2025-04-30 TNF-a 2nd gen
Car# 10:117265     VO: 9649     Date: 4/8/2025

Test- och 
kalibreringskassett

V E R I F I C A T I O N  C A R T R I D G E
BUFFER 1mL

1 2 3 4 5 6 7 8

BUFFER 1mL

BUFFER 1mL

9 10 11 12 13 14 15 16

BUFFER 1mL

C A L I B R A T I O N  C A R T R I D G E

DYE
25 µL

DYE
25 µL

BUFFER 1mL

1 2 3 4 5 6 7 8

BUFFER 1mL

BUFFER 1mL

9 10 11 12 13 14 15 16

BUFFER 1mL

BUFFER 1mL

17 18 19 20 21 22 23 24

BUFFER 1mL

BUFFER 1mL

25 26 27 28 29 30 31 32

BUFFER 1mL

SN 3456 2025-04-30 TNF-a 2nd gen
Car# 10:117265     VO: 9649     Date: 4/8/2025

32x4 Simple Plex-kassett

32 prover, 4 analyter

V E R I F I C A T I O N  C A R T R I D G E
BUFFER 1mL

1 2 3 4 5 6 7 8

BUFFER 1mL

BUFFER 1mL

9 10 11 12 13 14 15 16

BUFFER 1mL

C A L I B R A T I O N  C A R T R I D G E

DYE
25 µL

DYE
25 µL

BUFFER 1mL

1 2 3 4 5 6 7 8

BUFFER 1mL

BUFFER 1mL

9 10 11 12 13 14 15 16

BUFFER 1mL

BUFFER 1mL

17 18 19 20 21 22 23 24

BUFFER 1mL

BUFFER 1mL

25 26 27 28 29 30 31 32

BUFFER 1mL

SN 3456 2025-04-30 TNF-a 2nd gen
Car# 10:117265     VO: 9649     Date: 4/8/2025
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Starta och stänga av Ella
Följ procedurerna i detta avsnitt som beskriver hur du placerar, startar och stänger av Ella.

OBS! Ella ska placeras försiktigt med tillräckligt med utrymme bakom apparatens baksida så att operatören kan 
nå strömbrytaren och nätsladden med handen. Om operatören är vänd mot framsidan av Ella sitter strömbrytaren 
och nätsladden på den bakre panelen, nedtill till vänster.

Starta systemet
Starta Ella:

1.	 Slå på Ella.

2.	Slå på Ella:s dator och bildskärm.

3.	Logga in på datorn och starta 

4.	När Ella är påslagen tänds statuslampan (Figur 04). 
Se tabell 3 för en beskrivning av statuslampan.

Slå på Ella
Tryck på strömbrytaren på Ellas bakpanel.

Stänga av systemet
Stänga av Ella:

1.	 Stäng av Ella:s dator

2.	Stäng av Ella genom att trycka på strömbrytaren på 
bakpanelen.

TA B E L L //  03

Indikationer för statuslampan på Ella.
F I G U R  //   04

Statuslampa på Ella.

Ljusfärg Status

● Grön Ella försörjs med ström och klar 
att använda

● Blå Ella kör en kassett

● Röd blinkande Ett fel har inträffat (Ella kan 
eventuellt avge ett ljudlarm)
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Kapitel 3

Kora Simple Plex-kassetter
Inledning
Följande avsnitt är endast avsett som information. Se specifikationsbladet och produktdokumentationen för mer 
information om hur du kör en kassett. 

Köra en kassett
För att köra en kassett behöver du:

•	 Dina prover

•	 Din streckkodsmärkta kassettkit (Figur 05) som innehåller:

a.	 Tvättbuffert A

b.	Komponent(er) för provspädning

c.	 Kassett

Den typiska körningssekvensen är:

1.	 Förbered reagenser

2.	Förbered kassetten

3.	Konfigurera och kör med Ella

F I G U R  //   05

Kassettkit.

Kitförpackning Tvättbuffert och provspädning Kassett i påse, inklusive etikett 
med streckkod (inringad i rött)

Streckkodsetiketter
Kitetikett

Finns på utsidan av kassettpåsen, inringad i figur 05.
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Kassettetikett

Kassettens streckkodsetikett (se Figur 06) sitter direkt på kassetten och används för att spåra kassetten till kitet. 
Denna streckkodsetikett används för att bekräfta att kassetten som körs stämmer överens med kitet. 

Streckkoder för kassett-ID finns på kassettens framsida nära den nedre kanten som visas i Figur 06.

Bereda prover och reagenser
Plasmaprover (EDTA eller heparin) och serumprover

Serum- och plasmaprover som beretts med det rekommenderade protokollet på analysspecifikationsbladet, och 
som inte innehåller synliga partiklar, kräver inte ytterligare centrifugering före användning i en Simple Plex-analys.

För serum- och plasmaprover som innehåller synliga partiklar rekommenderar vi att partiklar avlägsnas med 
centrifugering och späds enligt anvisningarna i analysspecifikationsbladen. Metoden nedan är utformad för 
att bevara provet men kan justeras vid behov baserat på provtillgänglighet och partikelinnehåll. Metoden 
nedan simulerar provberedning för den minsta nödvändiga spädningen (MRD) på 1:2 som används i de flesta 
Simple Plex-analyser. För högre spädningsfaktorer kan seriespädning bli nödvändig för noggrannhet.

Centrifugering av serum- och plasmaprover

1.	 Alikvotera 35 μl serum eller plasma till ett mikrocentrifugrör.

2.	Centrifugera vid 8 000–10 000 g i minst 4 minuter.

3.	Alikvotera 30 μl av lämplig provspädning i ett annat mikrocentrifugrör.

4.	När centrifugeringen är klar, avlägsna 30 μl prov och var noga med att inte störa pelleten i botten.

5.	Tillsätt 30 μl centrifugerat prov till 30 μl alikvoterad spädning och blanda noggrant.

6.	Pipettera 50 μl av det 1:2-utspädda provet till det specificerade kassettinloppet.

Andra provtyper

Optimala spädningar ska fastställas av slutanvändaren.

V E R I F I C A T I O N  C A R T R I D G E
BUFFER 1mL

1 2 3 4 5 6 7 8

BUFFER 1mL

BUFFER 1mL

9 10 11 12 13 14 15 16

BUFFER 1mL

C A L I B R A T I O N  C A R T R I D G E

DYE
25 µL

DYE
25 µL

BUFFER 1mL

1 2 3 4 5 6 7 8

BUFFER 1mL

BUFFER 1mL

9 10 11 12 13 14 15 16

BUFFER 1mL

BUFFER 1mL

17 18 19 20 21 22 23 24

BUFFER 1mL

BUFFER 1mL

25 26 27 28 29 30 31 32

BUFFER 1mL

SN 3456 2025-04-30 TNF-a 2nd gen
Car# 10:117265     VO: 9649     Date: 4/8/2025

V E R I F I C A T I O N  C A R T R I D G E
BUFFER 1mL

1 2 3 4 5 6 7 8

BUFFER 1mL

BUFFER 1mL

9 10 11 12 13 14 15 16

BUFFER 1mL

C A L I B R A T I O N  C A R T R I D G E
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25 µL
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25 µL

BUFFER 1mL

1 2 3 4 5 6 7 8

BUFFER 1mL
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9 10 11 12 13 14 15 16

BUFFER 1mL

BUFFER 1mL

17 18 19 20 21 22 23 24

BUFFER 1mL

BUFFER 1mL

25 26 27 28 29 30 31 32

BUFFER 1mL

SN 3456 2025-04-30 TNF-a 2nd gen
Car# 10:117265     VO: 9649     Date: 4/8/2025

F I G U R  //   0 6

Kassett-ID-streckkoder.

Kassett-ID-streckkoder: Full 32x4 kassettyta (vänster). Detaljerad zoomvy visar kassettdetaljer och streckkod (höger).
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Förbered kassetten
OBS! När du hanterar kassetter rekommenderar vi att du alltid använder handskar och att plastbaksidan endast 
avlägsnas omedelbart innan kassetten placeras i Ella.

Metod

1.	 Skanna kitets streckkod på utsidan av kassettens vakuumpåse.

2.	Ta ut kassetten från vakuumpåsen.

3.	Skanna kassettens streckkod.

4.	Pipettera volymerna till kassetten i följande ordning:

a.	 Tvättbuffert enligt beskrivningen på din kassettinsats.

b.	Utspätt prov som matchar din kassettinsats.

5.	Dra av skyddshöljet från kassettens botten.

6.	Placera kassetten i Ella:s kassetthållare. 
 
OBS! När höljet har tagits bort ska du vara noga att inte vidröra botten av kassetten eller placera den på 
någon yta.

7.	Stäng kassettklämman och locket.

Sekvensen för beredning av en kassett visas i Figur 07.

A. Förbered kassetten

1.	 Skanna streckkoden.

F I G U R  //   07

Stegvis visuell guide för att förbereda en kassett för körning i Ella.

2.	Ta bort kassettens 
skyddshölje.

3.	Skanna kassettens 
streckkod för bekräftelse 
(valfritt).

4.	Ladda buffert.

5.	Ladda prov.

6.	Ta bort 
skyddshöljet/baksidan.
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B. Ladda kassetten i Ella

F I G U R  //   07

Stegvis visuell guide för att förbereda en kassett för körning i Ella (fortsättning).

1.	 Öppen dörr på Ella.

2.	Öppna kassettklämman.

3.	Öppen dörr och klämma på Ella.

4.	Ladda kassetten i Ella.

5.	Stäng kassettklämman.

6.	Stäng luckan.

VARNING: Var noga med att inte spilla vätska in i kassetöppningen 

Simple Plex Runner CE
En version av Runner CE utan grafiskt gränssnitt 
finns tillgänglig i de dolda ikonerna på skrivbordets 
aktivitetsfält (se Figur 08). Detta kan användas för att 
ändra inställningar för Runner, flytta till Ella-stadiet 
eller exportera diagnostiska filer eller andra datafiler. 

F I G U R  //   0 8

Ikon för Simple Plex Runner CE.

Om du klickar på Settings > Application (Inställningar > 
Program) i menyn visas dialogrutan Inställningar 
enligt Figur 09. Om du klickar på en rad i dialogrutan 
Inställningar visas en detaljerad beskrivning av det valda 
objektet längst ned i dialogrutan. Dessa beskrivningar 
finns i tabell 04 som referens. Knappen Save (Spara) 
aktiveras om ändringar görs.

F I G U R  //   0 9

Dialogruta med Simple Plex Runner  
CE-inställningar.
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F I G U R  //   1 0

Byta namn på Ella-instrument i inställningarna för Simple Plex Runner CE.

Om du klickar på Settings > Analyzer > Description (Inställningar > Analysator > Beskrivning) i menyn visas en 
dialogruta som kan användas för att byta namn på Ella-instrumentet (figur 10). Det instrumentnamn som definieras 
här skrivs till instrumentets inbyggda programvara och kommer att finnas kvar även om datorn ändras. Detta 
namn kommer att associeras med alla .cydat-filer som produceras av instrumentet.

Parameter Beskrivning

Use21CFRPart11Mode (Använd21CFRDel11Läge)
Bestämmer om 21 CFR del 11-support ska användas eller inte (inloggning, 
granskningsloggar, datakryptering osv.). 21 CFR del 11-support måste aktiveras för att 
denna inställning ska träda i kraft.

AutoLockInactivityMinutes 
(AutoLåsInaktivitetMinuter)

Bestämmer hur lång tid programvaran kan vara inaktiv innan programskärmen låses 
automatiskt i 21 CFR Part 11-läge. Ställ in på 0 för att inaktivera denna funktion.

LogoutWhenDone (LoggaUtNärKlar)
När detta ställs in på true (sant) (standard) loggas den aktuella användaren ut efter de 
trycker på Done (Klar) på panelen Kit Results (Kitresultat). När detta ställs in på false 
(falskt) fortsätter den aktuella användaren att vara inloggad och programmet 
fortsätter till panelen New Kit (Nytt kit).

AllowOutputFilePathChange 
(TillåtSökvägsändringUtmatadFil)

Om detta ställs in på false (falskt) kan kitresultatens filnamn och plats inte ändras. 
Detta gäller även den generiska LIMS-exportfilen (om aktiverad). Denna inställning 
gäller endast i 21 CFR Part 11-läge.

KitResultsFileDefaultFolder 
(KitResultatFilStandardMapp) Den vanliga katalogen där kitresultatfilen ska matas ut (*.cydat-tillägg).

AlwaysShow3DecimalsFor 
Concentration

Visa alltid 3 decimaler för koncentration. Standardinställningen för antalet decimaler som 
visas är baserat på hur många signifikanta siffror det finns i mätningen. Denna inställning 
ändrar också hur koncentrationsvärden exporteras.

GnrFilter (GnrFilter)
Filtret som används för att välja resulterande nanoreaktorer av glas (GNR). None 
(Inget) indikerar att alla GNR som hittas ska väljas. RFU och koncentrations-CV 
avlägsnar avvikande GNR-värden om procent-CV för alla tre GNR är över det 
specificerade tröskelvärdet.

GnrFilterPercentCVThreshold Den procentuella CV-tröskeln som används av GnrFilter (GnrFilter).

UseSampleStandardDeviation
Preferens som används för att beräkna procentuell CV. Om detta alternativ är 
markerat används provets standardavvikelse. I annat fall används populationens 
standardavvikelse (standard).

ResultWarning

Denna inställning gäller alla kassetttyper utom 32x8 och 72x2. Bestämmer om ett 
analytresultat ska färgas ljusrosa i vyn Resultatsammanfattning när den relevanta 
CV-procenten är större än eller lika med den angivna tröskeln. Om Use Filter (Använd 
filter) väljs bestäms tillämpligt CV och tröskelvärde med hjälp av inställningarna 
GnrFilter (GnrFilter) och GnrFilterPercentCVThreshold (GnrFilterprocentCVTröskel). 
Standardvärdet är UseFilterSetting (AnvändFilterInställning).

ResultWarningHighCVPercent 
Threshold (ResultatVarning HögCVProcentTröskel)

Procentuell CV som används av ResultWarning (ResultatVarning).  
Standardvärdet är 10.

ResultWarning2Gnrs  
(ResultatVarning2Gnrs)

Denna inställning gäller endast för kassetttyp 32x8 och 72x2. Fastställer att ett 
analytresultat ska skuggas ljusrosa i vynResults Summary (Resultatsammanfattning) 
när den relevanta CV-procenten är större än eller lika med det angivna tröskelvärdet. 
Standardvärdet är Off (Av).

ResultWarning2GnrsHighCV 
PercentThreshold 
(ResultatVarning2GnrsHögCVProcentTröskel)

Procentuell CV som används av ResultWarning2Gnrs (ResultatVarning2Gnrs). 
Standardvärdet är 20.

TA B E L L //  04

Inställningar i Runner CE.

Kapitel 3 18W-DOC-0023 Rev B



Parameter Beskrivning

AutoExportKitResults 
SummaryReport (AutoExportKitResultat 
SammanfattningsRapport)

Bestämmer om en sammanfattningsrapport för kitresultat ska 
exporteras automatiskt i slutet av en körning och varje gång 
kitresultatfilen sparas. Filens sökväg och namn kommer att vara 
samma som kitresultatfilen (.cydat eller .ecydat) förutom att 
filtillägget ändras till .pdf

DemoModeEnable Programmet fungerar i demoläge och kräver inte ett anslutet 
Ella-system.

KitRunDataRepositoryEnabled
Bestämmer om Kit Run Data Repository (KRDR) är aktiverat. KRDR 
inkluderar alla diagnostiska körningsdata för ett kit samt en 
säkerhetskopia av kitresultatfilen. Om alternativet är inaktiverat går 
det inte att återställa kitresultatfilen.

KitRunDataRepository
Rotkatalogen där alla diagnostiska körningsdata ska lagras för ett kit 
samt en säkerhetskopia av kitresultatfilen. Mapparna är ordnade 
efter datum och sedan efter kit-ID med körtid.

LocalKitRunDataRepository 
AutoPurgeEnabled

Bestämmer om äldre data i ett lokalt Kit Run Data Repository (KRDR) 
rensas automatiskt. Funktionen Automatisk rensning tillämpas inte 
för KRDR på en nätverksenhet eller delad enhet

LocalKitRunDataRepository 
AutoPurgeDaysToRetain

Bestämmer antalet dagar med data som ska sparas om 
LocalKitRunDataRepositoryAutoPurgeEnabled 
(LokalKitKörDataLagringsplatsAutoTömningAktiverat) är inställt på 
true (sant). Standardvärdet för hur många dagar lokala körningsdata 
för kit ska sparas är 90 dagar.

Generate2DMeasureScanData
Genererar ytterligare diagnostiska data för mätningsskanningar. 
Ökar utrymmet som används av Kit Run Data Repository med så 
mycket som 25 %. Standardinställningen är ”sant”.

AutoExportKitResultsTo 
GenericLIMSFile (AutoExport 
KitResultatTillGeneriskLIMSFil)

Bestämmer om en generisk LIMS-exportfil ska genereras 
automatiskt (eller inte) i slutet av körningen.

GenericLIMSExportFileDefaultFolder  
(GeneriskLIMS ExportFilStandardMapp)

Standardkatalogplats där den automatiskt genererade generiska 
LIMS-exportfilen ska skrivas ut (*.csv).

GenericLIMSAutoExport 
AppendSampleAggregateData 
(GeneriskLIMS AutoExport 
BifogaProvSamladeData)

När detta är inställt på true (sant) läggs provaggregatdata till i slutet 
av den automatiskt genererade LIMS-exportfilen.

GenericLIMSAutoExport  
ColumnsSameAsImport (GeneriskLIMS 
AutoExportKolumnerSammaSomImport)

Bestämmer om den automatiskt genererade generiska LIMS-
exportfilen använder samma kolumner som importfilen (om 
tillgänglig) eller inte. Annars används standardformatet.

ShowConcentrationOutOf 
RangeIndicationForExport

När detta är inställt på true (sant) visas koncentrationsvärden utanför 
intervallet för generiska LIMS-exporter som spädningsfaktorn enligt 
LLOQ- eller ULOQ-skalan med prefixet ”<” eller ”>” (t.ex. ”<2,00” 
eller ”>5000”). I annat fall lämnas koncentrationsvärden utanför 
intervallet tomma om de är false (falska)

GenericLIMSImportFileDefaultFolder Standardkatalogplats för den generiska LIMS-importfilen (*.csv).

UseGenericLIMSImportFile 
DefaultFolder

Bestämmer om standardkatalogen som specificeras i 
GenericLIMSImport FileDefaultFolder 
(GeneriskLIMSImportFilStandardMapp) ska användas eller inte. Om 
standardkatalogen inte används kommer katalogen att återställas 
tillbaka till den senast använda.

ComPortName Kommunikationsport till instrumentet.

BarcodeScannerComPortName Kommunikationsport till streckkodsläsaren.

BeepOnRunError Anger om Ella ska pipa när ett feltillstånd uppstår under en körning 
för att uppmärksamma användaren.

RequireCartridgeBarcodeScan Kräver att kassettens streckkod skannas på panelen New Kit (Nytt kit).

SelfTestDataRepository Rotkatalogen där alla självtestdata ska lagras. Mapparna är ordnade 
efter Ella-nummer och sedan efter testdatum och -tid.

TA B E L L //  04

Inställningar i Runner CE.
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Datalagringsplats
Simple Plex Runner CE-programvaran är konfigurerad för att lagra data som är associerade med varje kit och 
självtestkörning. Data placeras på datalagringsplatser som är organiserade efter datum och körning.

Kit Run Data Repository (KRDR)

•	 Tillhandahåller säkerhetskopiering/återhämtning av 
CYDAT för varje kitkörning.

•	 Tillhandahåller diagnostiska data i sällsynta fall då 
systemproblem inträffar.

 Självtestdatalager (STDR)

•	 Erbjuder en hämtningsbar historik för alla 
självtestkörningar.

•	 Tillhandahåller diagnostiska data i sällsynta fall då 
systemproblem inträffar.

Datalagringsplatsen kan konfigureras med hjälp av inställningarna för Simple Plex Runner CE-programmet.

Återställa en CYDAT
Om du använder KRDR och har felplacerat eller tappat bort en CYDAT från en körning, kan du återställa kitets 
CYDAT med alternativet Recover Kit Results (Återhämta kitresultat) i programvaran Simple Plex Runner CE med 
kommandot File > Recover Kit Results (Arkiv > Återhämta kitresultat). Om du väljer detta alternativ blir det möjligt 
att hitta CYDAT för det angivna kitet på lagringsplatsen och göra en kopia av den på en önskad lagringsplats.

Bläddra/hämta självtesterna
Genom att välja Självtesthistorik som finns i programvaran Simple Plex Runner CE under Tools > Self Test History 
(Verktyg > Självtesthistorik) kan du visa en lista över alla självtester i arkivet organiserat efter Ella-system och 
-datum. Du har också möjlighet att hämta/spara en eller flera självtestrapporter och alla självtestresultat kan visas.
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Kapitel 4

Underhåll av Ella
Inledning
Detta kapitel beskriver underhålls- och 
serviceuppgifter för Ella. Se kapitel 3 för information 
om hur du kommer åt Simple Plex Runner CE.

Använda verktygsmenyn i Simple Plex 
Runner CE 

Menyn Tools (Verktyg) (figur 11) används för att flytta 
XY-steget till fördefinierade platser (måste göras med 
klämman och locket stängda) och exportera loggfiler 
från diagnostiksystemet till en komprimerad fil som 
kan använas av teknisk support.

F I G U R  //   11

Verktygsmeny i Simple Plex Runner CE.

F I G U R  //   1 2

Ella-verifieringskassett.

Ella självtest
Ella-verifieringskassetten gör det möjligt för systemet att utföra en serie med diagnostiska tester som säkerställer 
att instrumentet körs korrekt. Runner CE-programvaran stödjer mekanismerna för att köra ett självtest, men det 
grafiska användargränssnittet måste utformas av analysens utvecklare för att utföra testet. Kontakta Bio-Techne 
för information eller hjälp om att utveckla det grafiska användargränssnittet. 

Resultaten kommer att sammanställas i systemets loggfiler. Dessa resultat ger värdefull felsökningsinformation 
till Bio-Techne-personal ifall systemunderhåll krävs. Därför rekommenderar vi att verifieringskassetten körs varje 
vecka för att skapa en körhistorik över systemets prestanda.

Din verifieringskassett tillhandahölls i en förvaringslåda som visas i figur 12 A och B. När du hanterar din 
verifieringskassett ska du använda handskar för att undvika att den blir smutsig. Verifieringskassetten har en yta 
för att försegla Ella:s pneumatiska gränssnitt och en autofluorescerande yta som en RFU-referens.

VARNING: Använd inte en verifieringskassett efter utgångsdatumet. Detta datum visas antingen på själva 
kassetten eller på dess kalibreringscertifikat 

A. 
Verifieringskassettlåda.

B. 
Kassett i kartong, 
streckkod uppåt.

 

Använda Move To-kommandon (Flytta till) i programmenyn på Simple Plex Runner CE
Öppna Simple Plex Runner CE

Objektfönsterposition
Kommandot Tools > Move To > Objective Window Position (Verktyg > Flytta till > Objektfönsterposition) visas för
att flytta till rätt position för att ta bort eller installera objektfönstret som är fäst vid värmeplattan.
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VARNING: Använd inte systemet om strömkabeln är skadad på något sätt

Kassettladdningsläge 
Kommandot Tools > Move To > Cartridge Load Position (Verktyg > Flytta till > Kassettladdningsläge) visas för 
att återgå till laddningspositionen om du tidigare har flyttat till objektfönsterpositionen eller fraktpositionen. 
Kommandot kan också användas i sällsynta fall när instrumentet inte återställer steget till laddningspositionen. 
Kontakta teknisk support hos Bio-Techne om detta inträffar. 

Fraktposition 
Tools > Move To > Ship Position (Kommandot Verktyg > Flytta till > Fraktposition) visas om Ella ska packas för frakt.

Förbereda Ella för frakt
Förbereda Ella för frakt:

1.	 Stäng klämman och locket

2.	Klicka på Tools > Move To > Ship Position (Verktyg > Flytta till > Fraktposition) på menyn i Simple Plex Runner CE.

3.	Vänta tills popuprutan Moving to shipping position (Flytta till transportposition) stängs.

4.	Stäng av Ella:

a.	 Stäng Simple Plex Runner CE antingen genom att klicka på File > Exit (Arkiv > Avsluta) från menyn eller 
Stäng (X) i det övre högra hörnet av programfönstret. Stäng programmet. Stäng av Ella:s dator.

b.	Stäng av Ella genom att trycka på strömbrytaren på bakpanelen.

Exportera systemloggar
Öppna Simple Plex Runner CE

Klicka på Tools > Export Diagnostic Data for Technical Support (Verktyg > Exportera diagnostiska data för teknisk 
support) för att exportera diagnostikinformation till en komprimerad zip-fil om teknisk support begär detta.

Underhåll och rengöring
Ella kräver årligt förebyggande underhåll som utförs av en Bio-Techne-representant. Annars krävs ingen 
användarkalibrering. Vi rekommenderar dock att du inspekterar systemet regelbundet. Observera eventuella 
skador på Ella:s hölje eller isoleringen på tillhörande kablar. Om skador på höljet indikerar att elektronikens 
skydd från fuktintrång eller laserljus har försämrats eller snart kommer att försämras, eller om kabelskadorna 
tyder på att kortslutningar eller öppna kretsar kan inträffa, ska du vidta lämpliga korrigeringsåtgärder beroende 
på situationen. I värsta fall måste produkten tas ur tjänst tills reparation har utförts. Kontakta kundtjänst för 
information om reparationer och reservdelar.

Följande material krävs för att rengöra och utföra underhåll på Ella:

1.	 10 % blekmedelslösning för hushållsbruk

2.	70 % etanollösning

3.	Milt rengöringsmedel

4.	Rena, luddfria trasor

5.	Linsdukar för engångsbruk (tillval)
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VARNING: Rengör inte den yttre ytan med etanol.

VARNING: Vid rengöring av objektivfönstret

•	 Använd inte blekmedel

•	 Vidrör inte objektivfönstret med något 
annat än den mjuka trasan

VARNING: Var försiktig att inte kontaminera objektfönstret när du rengör öppningen.

Rengöra kassettöppningen och objektfönstret
Kassettöppning

Vid behov kan Ella:s kassettöppning rengöras med en mjuk luddfri trasa fuktad med 70 % etanol. 

Objektfönster

Säkerställ att objektivfönstret är rent. Om rengöring 
krävs, använd en ren, mjuk luddfri trasa fuktad med 
antingen milt rengöringsmedel eller 70 % etanol 
tills fönstret är ”utstryksfritt”. Vi rekommenderar att 
du använder flera engångsservetter för att rengöra 
objektivfönstret (utstryksfritt), se Figur 13.

F I G U R  //   1 3

Kassettöppning och objektfönster.

Objektfönster

Kassettöppning

Rengöring och underhåll av fläktfiltret
Ella måste alltid få tillräcklig ventilation för kylning. Korrekt kylning krävs för att Ella ska uppfylla specifikationerna 
och undvika överhettning. Regelbundet instrumentunderhåll bör omfatta inspektion och rengöring av fläktfiltret 
var sjätte månad.

Gör så här för att rengöra filtret:

1.	 Ta bort fläktskyddet och fläktfiltret.

2.	Dammsug fläktfiltret för att rengöra det.

3.	Byt ut slitna eller skadade fläktfilter vid behov (artikelnummer 541401).

4.	Sätt tillbaka fläktfiltret och fläktskyddet.

Rengöra externa ytor
Stäng av och koppla ur Ella före rengöring. Vid behov ska alla utvändiga ytor på Ella endast torkas av med en 
fuktig, mjuk trasa som kan fuktas med milt rengöringsmedel. Använd endast en fuktig, mjuk trasa som kan fuktas 
med milt rengöringsmedel för att rengöra tillbehör som USB-kabeln eller streckkodsscannern.
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Kontakta oss 

Global    info@bio-techne.com, bio-techne.com/find-us/distributors   
Nordamerika    TEL 800 343 7475   
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Kina    info.cn@bio-techne.com, TEL 400.821.3475
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